
SmartDraw Menu Commands
File Menu
Edit Menu
View Menu
Shape Menu
Line Menu
Text Menu
Draw Menu
Window Menu
SmartDrawing Menu    (This is found in the SmartDrawing window)

To get help on a particular menu item, press Shift-F1, or press the help button on the 
toolbar, and then pull down on the menu item. To get help on a tool bar button, Press Shift-
F1 and click on the button.



Save Dialog
The Save Dialog lets you save your current drawing to a file on disk. Files can be re-opened 
later for further work. Each file must be stored with a file name you give it. 

The File Name box lets you type in a name for the file, or pick one from the list below by 
clicking on it. If you type the name and do not supply a three letter extension at the end    
(like .SDR), the current extension is added automatically. Names (not counting the 
extension) can only be 8 letters long.

The Directories list shows the current DOS directory that the File Name list is showing. To 
search in other directories, double click on the names shown in this list. SmartDraw 
remembers the last directory you used to open or save a file with this dialog and 
automatically sets the directory there when you use it again.

The List Files of Type control changes the extension of the files shown in the File Name 
list and the type of the file saved. SmartDraw File has an extension SDR and is the usual 
choice. SmartDraw Template saves the current drawing as SmartDraw Template. This is 
the same as a normal file but with the extension SDT. When template files are opened, an 
untitled copy is made and the original is left closed. When saving as a template, the 
drawing retains its current file name.

The Drives control shows the letter of the drive that the File Name list is showing. Use this 
control to change drives by clicking on it and picking another from the list.

The OK button confirms your choice of file and puts away the dialog. The Cancel button 
puts away the dialog without selecting a file. 

The Network button, if you have one, lets you browse your network and connect other 
drives. Non-networked users do not have this button.

See Also: Creating, Opening and Saving Files



Open Dialog
The Open Dialog lets you re-open a drawing that has been previously saved on disk as a 
file. Only documents with names ending in .SDR are normally shown in the list of files to 
open, unless you select another extension using the List Files of Type control described 
below.

The File Name box lets you type in a name for the file to open or pick one from the list 
below by clicking on it. If you type the name and do not supply a three letter extension at 
the end    (like .SDR) , the current extension is added automatically.

The Directories list shows the current DOS directory that the File Name list is showing. To 
search in other directories double click on the names in this list. SmartDraw remembers 
the last directory you used to open a file with this dialog, and automatically sets the 
directory there when you use it again.

The List Files of Type control changes the extension of the files shown in the File Name 
list. Normally this is "SmartDraw File" (SDR). The second choice, SmartDraw Template, 
opens files with the extension SDT. These files are the same as SDR files but they open as 
an untitled copy, leaving the original intact. This is useful if you want to create files with 
your own initial settings, or with a set of initial shapes, to serve as the starting point for 
other drawings. SmartDraw comes with several sample templates.

The Drives control shows the letter of the drive that the File Name list is showing. Use this 
control to change drives by clicking on it and picking another from the list.

The OK button confirms your choice of file and puts away the dialog. The Cancel button 
puts away the dialog without selecting a file. 

The Network button, if you have one, lets you browse your network and connect other 
drives. Non-networked users do not have this button.

See Also: Creating, Opening and Saving Files



Print Quality
The Print Quality controls the number of dots per inch (the resolution) that the printer will 
use to represent the page being printed. The higher the quality the more memory your 
printer may need to print the drawing.



Collate
For printers that do not have enough memory to store a whole page (like dot matrix 
printers) this is often checked and made inactive.

Checking the box will cause multiple copies of a drawing that does not fit on one page to be
printed so that the pages are in collated order: page 1, 2, 3...., followed by    page 1, 2, 3.... 
and so on.

Unchecking the box, will cause all copies of page 1 to be printed, followed by all copies of 
page 2 and so on. Non-collated printing (where available) is often faster than collated 
printing.



Print on One Page
Checking this box causes the entire drawing to be printed on a single page. This is 
achieved by scaling the image down to fit on the page and may result in reduced legibility.



Print No Color
Checking this causes the drawing to be printed in black and white only. All borders, lines 
and text are made black, and the background and shape fills are made white. This often 
gives sharper results with non-color printers, and requires much less printer memory than 
printing in color.



Print Page Numbers
Checking this causes a footer showing the number of the page to be printed at the bottom 
of each page.



Print To File
This causes the printed image to be stored in a file on disk instead of being printed to the 
printer. This is useful for making Postscript files to send to a service bureau when using a 
Postscript driver.



Copies
This sets the number of copies that you want to print.



Print Range
Control the range of pages that will print. Only the rectangular array of pages that contain 
part of the drawing are printed, beginning with the top left and continuing across the top 
row, to the second row and so on. There are three choices:

All means all pages containing the drawing are printed

Selection means all pages that contain lines and shapes that are Selected are printed.

Pages allows the entry of a specific range of pages, with page 1 being the top-left as 
described above.



Creating, Opening and Saving Files
When you first start the program a new drawing is normally created automatically. Each 
drawing has its own scrollable window. You may have up to 4 different drawings open at the
same time.

New drawing windows may be created by using the New command under the File Menu, 
or by pressing the New File button in the tool bar.
A drawing window is closed using the Close command under the File Menu, or by double 
clicking in the top-left corner. Any changes you have made to your drawing DO NOT 
become permanent unless you save them. If you have made changes since you last saved, 
you are reminded to save them before the window closes.

Drawings are saved to a file on disk using the Save or Save As commands under the File 
Menu. New drawings must be given a name before they are saved and so either command 
presents the Save Dialog. For drawings that already have a file name, use the Save As 
command only to save to a different file name. To save and retain the same file name use 
the Save command. The Save button on the tool bar executes the save command.

Once a file has been saved to a file on disk it can be re-opened using the Open command 
under the File Menu, or the by pressing the Open button on the tool bar. This presents the
Open Dialog. 

The Options Dialog can be used to set the way new documents are created, and what 
happens when the program starts up.



Print Dialog
The Print Dialog controls the way a drawing is printed. 

The current target printer is shown at the top of the dialog. This can be changed by 
pressing the Setup button. Setup presents the Printer Setup Dialog.

 Print Range
 Print Quality
 Copies
 Collate
 Print To File
 Print Page Numbers
 Print No Color
 Print on One Page



Printing

The Print command under the File Menu is used to print a drawing. This presents the Print 
Dialog. Pressing OK at this dialog begins printing.

The largest drawing supported is 50 inches square. In the Fit to Window view, the 
boundaries of the pages over the whole area of the drawing are shown as dotted lines. If a 
drawing is larger than one page, the rectangular array of pages that the drawing touches 
will be printed. This is shown below

In the example above, four pages will be printed, marked 1,2,3, and 4. The most top-left of 
the pages that contain the drawing is printed as page 1. The remaining pages are then 
printed, starting with the next page in the same row as page 2, and then forward to the 
bottom right across each row.

When a page range is specified in the Print Dialog, the page numbering follows this 
scheme. For example, to print the bottom right page only, in the case shown in the picture 
above, a range of page 4 through 4 is specified.

The Printer Setup Dialog is used to set the target printer, the page orientation and other 
printer-specific parameters. This information is stored with the drawing. If you choose a 
specific printer (i.e. not the default printer) for a drawing, the next time you print it, it will 
automatically select the same printer, no matter what the setting for the default printer is.

You can also choose to print with 1/6" overlap between each page of a multi-page drawing. 
This causes a small strip of each page to be repeated on the pages that surround it. This 
makes pasting together large drawings easier.



Overlap
Checking this box causes a small strip of each page to be repeated on the pages that 
surround it. This makes pasting together large drawings easier.



Paper
Select the paper size from the list.



Orientation
Choose either landscape or portrait, as shown by the icon.



Printer
Selecting the Default Printer will cause this drawing to print to whatever the default 
printer (set using the Control Panel) is set to. 

Selecting a Specific Printer will cause this drawing to print to the chosen printer, no 
matter what the default printer is set to.



Printer Setup
This dialog is used to set the target printer, the page orientation and other printer-specific 
parameters. This information is stored with the drawing. If you choose a specific printer (i.e.
not the default printer) for a drawing, the next time you print it, it will automatically select 
the same printer, no matter what the default printer setting is.

 Printer
 Orientation
 Paper
 Overlap



Undo
The Undo command reverses the most recent operation. If used, the command changes to 
Redo, which returns the program to its state before the undo command was used.    
Repeated use of Undo, toggles the program between the current state and the state before 
the most recent operation. 

If the command is gray, there is no previous state to return to.



Cut, Copy and Paste
The Copy command transfers all or part of the drawing to the clipboard. Its behavior 
depends on what is selected.    

When nothing is selected, Copy copies a representation of the whole drawing to the 
clipboard (as a metafile).    This can be pasted into word processors and other applications. 
If an application supports Object Linking and Embedding (OLE) as a client, pasting the 
drawing into it creates an OLE link back to SmartDraw so that double-clicking on the 
pasted drawing will open it up in SmartDraw again.

When one or more shapes or lines are selected, Copy copies a drawing made up of just 
those shapes to the clipboard. It also copies the shapes and lines themselves so that they 
can be pasted into another SmartDraw drawing, or somewhere else in the same drawing. 
Copying is also used to combine selected shapes and lines into a new SmartDrawing.

The Clear command is only available when shapes or lines are selected. It removes 
(deletes) the selected objects from the drawing. 

Cut is a combination of Clear and Copy. It first copies any selected objects to the clipboard, 
and then deletes them.

Paste adds items currently on the clipboard to the drawing. If the clipboard contains 
shapes or lines copied from SmartDraw, these are added to the current drawing. If the 
clipboard contains one of the graphic formats supported by SmartDraw, a Picture Object is
added. SmartDraw does not support OLE as a client, only as a server.

When text is being edited, Copy, Cut and Paste act on the text only in the standard 
Windows way.



Duplicate
The Duplicate command makes a copy of the selected lines and shapes and adds them to 
the drawing offset by a small distance from the original objects. 

The duplicated objects are automatically selected so that they can be moved as a group 
(by holding down the Shift key). If the newly duplicated objects are moved with respect to 
their original copies, the new distance between the new set of objects and the original set 
is used as the offset for further duplications. This makes creating evenly spaced rows and 
columns of lines or shapes very easy. An example makes this clear.

The illustration below shows the steps involved in making a column of evenly spaced lines.



Selecting Objects

Lines and Shapes become selected when they are clicked on with the mouse and the Arrow 
button on the toolbar is depressed. 

Once selected, the colors, borders and other attributes of objects can be changed using the
menu commands. Typing from the keyboard inserts text into selected shapes.

Selected objects are shown with Handles on the corners and sides as shown below.

The most recently selected object is always shown with solid (black) handles and is called 
the Target object. Other selected objects are shown with hollow handles. The target object 
is the one others align with, and become the same size as, when using the Align and Make 
Same Size commands.

Objects that are Linked to other objects have round handles at their connected points.

There are many ways to select objects. Clicking on the border of an object selects it and de-
selects all other objects. Holding the Shift Key (on the keyboard) down while clicking, 
causes any other selected objects not to de-select. Clicking on a selected object with the 
Shift key depressed, de-selects it (and only it).

Holding the mouse button down while dragging the mouse across the drawing window 
draws a temporary dotted rectangle. Any objects completely enclosed by this rectangle are 
selected. Holding the Shift key down while this is done adds these objects to any existing 
selection

Sometimes, it is hard to click on, and select, the object that you want because of other 
objects that lie on top (or in front) of it. There are two ways to overcome this. You can 
select the objects on top and Send to the Back, or you can drag around all of the objects, 
selecting them all. Shift-clicking on the objects in the front now de-selects them, leaving 
only the object you want still selected.

Shapes can always be selected by clicking on their border. Shapes that are not transparent 
can be selected by clicking inside their borders.



Colors and Shadows
The Colors and Shadow command, under the Edit Menu, allows you to apply a design 
Style to your drawing.    A style is a color scheme, specifying the color of the drawing 
background, shapes, borders, lines, text and shadows, and a shadow type. Styles are 
selected from the Colors and Shadow Dialog.

Many pre-built styles are provided by SmartDraw. These are listed in the Select a style 
list box. A preview of the style's appearance is shown in the Sample window to the right of 
it. Changing the style selection changes the preview. You can browse through the available 
styles using the up and down arrow keys to change the selection. 

Once you have selected the style that want, press the OK button and the colors and 
shadow styles are applied to your drawing. This is a very quick and easy way to change all 
the colors in a drawing in one operation. You can undo any change you make, or you can 
apply another style to try any number of different "looks".

If you select a shadowed style, shadows are applied to your shapes. Some styles also apply
the same kind of shadow to lines and to text. The 3D styles give the raised and sunken 
looks common in Windows dialogs.

You can control whether a shadowed style applies the shadows to lines and text by 
checking the boxes in the shadow section of the dialog:

 Apply to Lines
 Apply to Text
 Reverse Text Shadow

Pressing the Define button in the dialog allows you to add your own styles, or to modify 
the standard ones.

See Also; Defining Color and Shadow Styles



Reverse Text Shadow
This option is only available if the raised or sunken 3D shadow styles are chosen. Checking 
this box applies the reverse text shadow: Raised if the shape shadow is sunken, sunken if 
the shape shadow is raised. This can give an interesting effect.



Apply to Text
Checking this box applies the shadow style selected to text as well as to shapes. This is 
only visible if a shadow style is selected. Text does not look good shadowed unless it has a 
point size of 18 or greater.



Apply To Lines
Checking this box applies the shadow style selected to lines as well as to shapes. This is 
only visible if a shadow style is selected, and is forced to be on for the raised and sunken 
shadow styles.



Angle
The four push buttons show the current angle for the shadow. Pressing one changes the 
selection to the angle shown on its face. These controls are only visible if one of the 
shadow styles in the right column of the shadow control is selected.



Shadows
The six push buttons show the range of shadow styles available with the top left button 
representing no shadow. If a shadow style in the right column is selected, the angle of the 
shadow can also be controlled using the controls labeled Angle.

Shadows can be applied optionally to lines and text. Check boxes control these selections.



Colors
Seven color panels are displayed showing the current color scheme. Pressing on any color 
panel with the mouse displays the color menu. Use the menu to change the color selection.

The selection shown on the left represents the Transparent color.

The highlight color is only used by the raised and sunken three dimensional shadow 
styles.



Delete Button
This button is active when the name in the Name field matches the style selected in the 
list. Pressing it removes the selected style from the list.



Change Button
This button is active when the name in the Name field matches the style selected in the 
list. Pressing it changes the selected style to the current color and shadow settings.



Add Button
This button is active when the name in the Name field does not match the style selected in
the list, and the settings for colors and shadow have been changed. Pressing it adds the 
current color and shadow settings as a new style.



Name
The text in the name field is the current name of the style being edited. If this matches the 
name of the style that is shown selected in the list, the Change button is active, and the 
current style is changed if it is pressed. If the name does not match the selected name in 
the list, the Add button is active and pressing it adds a new style to the list. If there is 
nothing typed in the field, both buttons are inactive.



Sample
This area shows a preview of the current style as the selection in the list is changed, and as
the settings for the selected style are changed.



Rename Button
This button becomes active when the name of the selected style has been changed, but 
the parameters have not. Pressing it renames the current style.



Select a style to edit
Selecting an item in this list selects the style for editing. The style's name is copied into the
Name field, and the Change button becomes active. Any changes to the previously 
selected item's style are canceled.



Defining Color and Shadow Styles
You may change existing styles or add new styles with the Define Colors and Shadows 
Styles dialog.

 Select a Style To Edit
 Sample

 Name
 Add
 Change
 Rename
 Delete
 Colors

 Shadow
 Angle
 Apply to Lines
 Apply to Text
 Reverse Text Shadow

Changes made in this dialog do not become permanent unless the OK button is pressed. 
The newly defined styles are then available in the Colors and Shadow Dialog.



Adjustment
This field is only visible if the shape selected for the button may be adjusted in some way. 
The parameter value represents a proportion of the width or height of the shape and is 
usually limited to a range of 0.1 to 0.4, or sometimes less. The effect of the change can be 
seen in the preview window if you click on it or click in another field.

Changing the shape assigned to the button will change the adjustment to its default value 
for that shape.



Select Shape
A button shows the shape currently selected for this toolbar location. Pressing the button 
presents a menu of standard shapes. Selecting one changes the assignment of the button 
to the selected shape.



Preferred Size
The width and height fields control the size of the shape associated with this button when 
one is created using a drag and drop operation. For circles, and other shapes that can only 
be sized proportionately, changing one value changes the other, so as to maintain the 
same proportions.



Editing the Toolbar
The buttons on the toolbar that show shapes can be configured to show any of the 24 
standard shapes using the Edit Toolbar Location dialog. 

To bring this into view, either double-click on the button that you want to edit, or select the 
button by clicking on it once and then select the Toolbar item under the Edit menu.

This dialog can also be used to set the size of the shape when it is added to the drawing 
using a drag and drop operation, as well as the "adjustment" parameter for certain shapes. 
The adjustment parameter controls the degree of roundness for rounded rectangles, how 
angled arrows are, etc. 

Changing these parameters has no effect on any existing shapes in your drawing. They 
affect only new shapes that you add later.

Press the buttons below for an explanation of the controls in the dialog:

 Preferred Size
 Select Shape
 Adjustment



Hints
SmartDraw will display hints for beginning users if this box is checked. These are dialogs 
that pop-up automatically when you try to use certain features of the program for the first 
time. They attempt to explain what you are about to do and provide a direct route to more 
detailed help. 

Each hint will only appear once in each SmartDraw session. Hints can be switched off from
any Hint dialog. We recommend that you leave the Hints switched on the first few times 
that you use the program.



New Drawing
When a new drawing is created using the New command under the File menu, or 
automatically when the program starts up, SmartDraw can either create one with the 
normal defaults, or it can look for the file "SMRTDRAW.SDT" and attempt to open it as a new
untitled drawing, or Template.

You can use the template feature to control the default colors, styles and other drawing 
parameters for newly created drawings.



Start Up
When SmartDraw first starts up it can either show the Welcome dialog, create a new 
empty drawing, or show the Open Dialog. Make your choice by clicking on the appropriate 
radio button.



Options Dialog
The Options Dialog controls the way the program behaves when starting up and when a 
new drawing is created. Press the buttons below for an explanation of the controls in the 
dialog:

 Start Up
 New Drawing
 Hints



Changing the View
All SmartDraw drawings may occupy an area of up to 50 inches square. Unless your 
drawing is very large, you work only with a small part of this total area, normally up in the 
top left corner. The commands: 200%, 150%, 100%, 75%, 50%, Fit to Page, and Fit to 
Window, shown under the View menu, control the scale used to display your drawing in 
the drawing window. 100% is the scale used by most Windows programs to show objects at 
their natural size. The other scales make objects look smaller or bigger than they really are.

These scale factors have no effect on the size of shapes and lines when they are 
printed out.

The Fit to Window selection shows the whole 50 inches of the drawing in the document 
window. Since the size of a page for the currently selected printer is normally much smaller 
than this, to print a drawing of this size, SmartDraw must "tile" it and print pieces of the 
drawing area on more than one page. The boundaries of these tiles or pages are shown as 
dotted lines.

The Fit to Page selection scale the window so that at least one full page is showing. This 
view and 50% also show the page boundary lines.

The toolbar shows two buttons that you may use to change the scale factor. Pressing on the
button on the left, with the minus sign in the magnifying glass, selects the next smallest 
view menu item. Pressing the button on the right selects the next largest view. 

As the view changes, SmartDraw attempts to keep all selected objects (or all objects if 
none are selected) visible. If this is not possible (because the window is too small), it 
attempts to center the selected group in the window.

You can specifically select an object to scale up and bring into view by holding down the 
Control and Shift keys at the same time. This changes the cursor to a magnifying glass.    
If the view is set to Fit to Window, or Fit to Page, the cursor has a plus sign in the 
middle, and clicking on an object sets the scale to 100% and brings the object into view 
directly under the cursor.

If the view is set to 50% or above, the cursor has a minus sign in the middle, and clicking 
selects the Fit to Window view. A quick way to inspect a particular object is to hold the 
shift and control keys down, click once to select Fit to Window view, find the object that you
want to inspect and click on it. This brings the object into view at 100%.

See Printing.



Rulers and Coordinates
Drawings may have rulers showing along their top and left edges. These show dimensions 
that will match those printed out. A line an inch long next to the ruler should be an inch 
long when printed. 

Rulers can be hidden or shown using the Show Rulers menu item under the View menu. 
This toggles the state of rulers for all drawings in the program on and off. When rulers are 
set to show, the menu item is checked. Rulers are not shown when the view is set to Fit To 
Window.

The top-left corner, where the rulers cross, normally shows a digital display of the current 
position of the cursor in the units of the ruler. This can be toggled on or off using the Show 
Coordinates View menu item.

Clicking in a ruler displays a temporary dotted line that follows the position of the cursor. 
This can be used to measure the positions of objects in the drawing. Clicking in the corner 
where the two rulers cross and dragging shows two of these lines forming a "cross hair" 
arrangement. When Snaps are turned on, these temporary lines snap to the ruler 
graduations.

The units shown on the rulers are controlled by the Measurement setting in the 
International control in the Control Panel. If this is English the units are in inches with 
1/10" divisions. If the setting is Metric, the units are in cm with mm divisions. The size of 
the divisions controls the spacing of the Snaps.



The Toolbar
SmartDraw usually shows a row of buttons under the menu bar. This is called the Toolbar.
It can be shown or hidden by selecting the Show Toolbar command under the View menu.

The top row of buttons are short cuts for the menu commands. To find out what each one 
does, hold the cursor over a button for a second or more. A small yellow window will pop-
up, describing its purpose. This is called a ToolTip.

The buttons in the second row are used for drawing. One of these buttons is usually pushed
in. What happens when you click with the mouse in the drawing depends on which of these 
buttons is currently pushed in.

 When the arrow button is pressed, clicking in the drawing selects, moves or grows existing 
objects.

 When the text    button is pressed, clicking in drawing begins a new background text 
object. Clicking in a shape opens it for text entry.

 When the line button is pressed, clicking and dragging in the drawing draws a straight line.
Dragging and Dropping also draws a line.

 When the segment line button is pressed, clicking and dragging in the drawing draws a 
segmented line. Dragging and Dropping also draws a segmented line.

 When the segment line button is pressed, clicking and dragging in the drawing draws an 
arc. Dragging and Dropping also draws an arc.

The remaining buttons draw the shape that they show. The shape buttons can be 
configured to show any of the 24 standard shapes, and you can control the default size and
proportions of the shapes that are dragged and dropped. This is done by double clicking on 
the button, or by first selecting the button and then selecting the Toolbar item under the 
Edit menu.



Text and the Sizing of Shapes
Regular shapes, SmartDrawings and background text objects all grow if more text is 
entered than will fit inside them. There are three ways that they can grow.

Horizontally and Vertically
This is the default for most shapes. The shape grows so as to maintain its proportions.

Horizontally
This is the default for background text objects and the text that appears below or above 
pictures and SmartDrawings. New text is added on the current line. Wrapping occurs only 
when an <Enter> is typed.

Vertically
Text "wraps" within the width of the shape, like a word processor does when the text 
reaches edge the of the page. The shape grows vertically as new lines are added.

The Grow Direction
The direction that the shape grows is determined by the Alignment command under the 
Text menu. A shape maintains a fixed point according to its text alignment. If its text is 
centered, the center of the shape remains fixed and it grows outwards from the center. Left 
justified text remains fixed at its left edge and grows on the right. Top justified text grows 
downwards and so on.



Entering Text
There are two ways to enter text: Inside a shape or in a background text object.

Entering Text Inside Shapes
Text may be entered inside the 24 standard shapes that appear on the toolbar and inside, 
or underneath, many SmartDrawings. As text is added to a shape it fills up and grows to 
accommodate the text.

If a shape is selected, just starting to type opens it for text entry. Shapes can also be 
opened for text entry by double clicking on them, or by pressing the text button on the 
toolbar and clicking once on the shape.

Entering Background Text
If the text button on the toolbar is pressed in, then clicking in the background of the 
drawing opens a text entry session. Text entered forms a new object called a Background 
Text Object. This is essentially a rectangle shape with no border.

Background text objects may be selected and opened for further text entry like any other 
shape. They may have a border and colors like any other shape. They do have some 
properties that differ from the rectangle shape however.

Text objects align to the Snaps according the baseline of the first line of text, and not to 
their top left corner like other shapes. They are deleted if all their text contents are deleted.
They can also be rotated by 90 degrees for sideways text.

Entering and Editing Text
When a shape or background text object is opened for text entry, the standard Windows 
insertion point appears. This is a flashing vertical line. All of the normal Windows text 
editing conventions apply: Dragging with the mouse selects text (shown as inverted). 
Selected text can be cut, deleted or copied. The font, size, style and color of selected text 
can be changed using commands on the Text menu.

See also: Selecting a Typeface, Rotating Text, Text Alignment, Inserting Symbols



Style
This shows a list of styles (weights) for the selected font.    If no style is shown selected, 
then the range of text selected has more than one style. Leaving this list un-selected will 
result in no change to the style over the selected range.



Size
This shows a list of sizes for the selected font. If the size you want is not listed you may 
enter it in the editable field. If no size is shown selected, then the range of text selected 
has more than one size. Leaving this list un-selected will result in no change to the size 
over the selected range.



Font
This shows a list of all True Type fonts in the system. If no font is shown selected, then the 
range of text selected has more than one font. Leaving this list un-selected will result in no 
change to the font over the selected range.



Selecting a Typeface
There are two ways in which the font, size and style of text can be changed: When a text 
entry session is active, and range of text is selected, and when a shape containing text is 
selected.

In both cases the Typeface command under the Text menu presents the standard Font 
Dialog. Selecting a font, size, style combination from this dialog applies the new typeface 
either to the range of text selected or to all the text in the selected shape.

Press the buttons below for an explanation of the controls in the dialog:

 Font
 Size
 Style

The sample window shows a preview of the typeface selected.



Text Rotation
Background text objects may be rotated by 90 degrees in either direction using the 
Rotation menu under the Text menu. 

When rotated text is opened for text entry, it flips back to the normal 0 degree rotation, 
leaving a ghost image of its rotated form to indicate that the flip to 0 degrees is temporary.



Text Alignment
Text can be positioned inside a shape so that it aligns with the left edge, the right edge, or 
is centered horizontally. It can also be flush justified so that it aligns with both the left and 
right edges of the shape. Vertically, the text can be positioned so that it aligns with the top 
edge, the bottom edge, or is centered vertically. The four horizontal and three vertical 
settings can be combined into a total of 12 combinations. These 12 combinations are 
shown graphically in the Alignment menu under the Text menu.

The Alignment command can be used when a shape that contains text is selected, or when 
a shape is open for text entry. It affects the way text is displayed within the shape and the 
way the shape grows when text is added. (See Text and the Sizing of Shapes).

Aligning text in a background text object has little noticeable affect because there is no 
extra shape size to position the text relative to.

Flush alignment is similar to left alignment except that wrapped lines have smooth right 
edge as well as left edge. Left aligned text has a ragged right edge.



Insert Symbol
The Insert Symbol command is a quick way to insert a selection of common symbols into 
text being edited. It is active only when a text entry session is open.    Selecting one of the 
symbols from the menu inserts it into the stream of text.

This command relies upon the Wingdings font being installed on your system.



Arranging Lines and Shapes
Use Snaps
The Use Snaps command under the Draw menu, toggles the snap mechanism on and off. 
When Snaps are on, and the menu item is checked, the edges of shapes and lines 
automatically align with the tick marks on the rulers as they are created, moved, or re-
sized. This makes aligning the edges of objects, when simply dragging them with the 
mouse, very easy.

Align
The align commands under the Draw menu align the edges of selected objects with the 
target object. The Left and Right commands align the left and right edges of the selected 
objects with the left or right edge of the target object respectively. The Center Vertically 
command aligns the point centered between the left and right edges. Top, Bottom and 
Center Horizontally work similarly but in the vertical direction.

Make Same Size
This command is used to re-size all the selected objects so that they have the same Width,
Height or Both, as the target.

Bring to Front and Send to Back
Objects (shapes and lines) may lie on top of other objects. You can change the front to back
order of the objects in your drawing using the Bring to Front or Send To Back commands
under the Draw Menu. Bring to Front moves any selected objects in front of the non-
selected objects. Send to Back does the reverse. These commands have no noticeable 
effect unless objects overlap one another.

Lock Object
Selected objects may be Locked and unlocked using the Lock Object command. Locked 
objects show their selection with gray handles instead of black and cannot be moved until 
they are unlocked. This is useful if you want to place an object behind others and don't 
want to accidentally move it while clicking on the objects in front of it. Locked objects 
cannot be opened for text editing. Their properties (color etc.) can be changed using the 
menu commands however.

Allowing Shapes and Lines to Link
See Linking.



Linking Lines and Shapes
SmartDraw lets you link objects together so that they stay connected when you move or 
re-size them.    
The most common case is a line linked to two shapes. Moving one of the shapes changes 
the size and shape of the line as shown below.

Creating a Link
When line linking is enabled, a line may be linked to a shape by moving one end over the 
border of the shape. This is done either by growing or moving the line using the mouse. 
When the end of the line approaches the shape's border, a series of round solid circles 
appear, indicating the points on the border that the line may link to. These are called 
connect points.    This is shown below.

The end of the line then snaps to the closest connect point and the mouse cursor becomes 
an "anchor". Releasing the mouse while in this state establishes a link between the line and 
the shape.

Links can also be created when objects are first added to the drawing. If the "pencil" method
is used to add a line, and the initial mouse click is inside the border of a shape, a link to this 
shape is immediately established with the beginning of the line. This is shown by the display
of connect points for the shape that was initially clicked upon. The end of the line that 
follows the mouse can also be linked to a second object by dragging it to its border. Hence 
the linking of two shapes with a newly created line can be achieved in one drawing 
operation.

Breaking a Link
Links may be broken using the reverse of the link creation process. The end of the line is 
moved away from the border of the object using the mouse. Deleting either object also 
breaks the link.

Targets and Linked Objects
In any link relationship, the object that displays the connect points is the Linked Target, 
and the object linking to it is called the Linked Object. The linked target usually controls 
the positioning of the linked object. If the target is moved, the linked object either moves, 
or re-sizes to maintain the link.

Lines are allowed to have one or two linked targets. With one target, lines move when their 
target moves. With two, they change shape and/or re-size when one of their targets move.

When a line that is linked to one target is moved, the link is broken. When a line that is 
linked to two objects is moved, all three are moved as a group.

Turning Linking On and Off



The Draw menu had commands that turn linking off. This is very useful when you want to 
draw a finely detailed picture and you would like to prvent lines drawn close to shapes (and
each other) from linking together. The Allow Lines to Link command toggles the ability of
lines to link to other objects. The Allow Shapes to Link command toggles the ability of 
shapes to link to each other. This is off by default.

Linking Shapes to Other Shapes
When the Allow Shapes to Link item under the draw menu is checked, then one shape 
can be linked to another. Shapes can never link to lines where a line is the linked target. 
When shapes link, any one of the grow handles on the linked shape can snap to any one of 
the connect points on the target shape. Shapes can only link to one target at a time.

This feature is useful if you want to attach a background text object to a shape so that it 
follows the shape around when it is moved or re-sized.

Linking Lines to Other Lines
Lines can link to other lines as a linked target. This is useful for creating branched networks
of lines that remain attached when the targets change size or move.



The Window Menu
The Window menu lets you arrange any open drawing windows, or bring one to the front.

Cascade Windows arranges them to overlap each other, offset from the top left hand 
corner of the program window. 

Tile Windows arranges them to fill the program window as non-overlapping tiles.    

The remaining items on the menu list the open windows. Selecting one of these items 
brings its window to the front.



Object Linking and Embedding (OLE)
SmartDraw is an Object Linking and Embedding (OLE) Server. This is a feature that 
allows other Windows programs that support OLE to insert SmartDraw drawings directly 
into their own documents.

A program that allows users to insert OLE objects into their own documents are called OLE 
Clients. Examples are Windows Write, Microsoft Word, Excel, PowerPoint, Lotus 1,2,3 , 
WordPerfect and most other major applications. To understand the features of OLE more 
clearly we will use Microsoft Word as an example OLE Client application.

Embedding
Word, and other client programs, all have an Insert Object menu item. If you use this 
command, you are presented with a scrolling list showing the names of the OLE Server 
documents that are installed on your system. SmartDraw Drawing should appear in this 
list. If you make this selection, SmartDraw will be launched, or will come to the front, with 
a new empty drawing. Whatever you draw in this window will show as a picture in your 
Word document when you save the drawing. This is called Embedding.

The SmartDraw drawing seen in your Word document actually contains all the information
that would be stored inside a SmartDraw file. If you double-click on the drawing in Word, 
SmartDraw is launched again, and comes to the front showing the drawing you 
embedded. You can make changes to this drawing and save it back to Word again.

You can also embed a copy of a SmartDraw drawing in Word (and other clients) by 
copying the drawing from SmartDraw, and pasting it into Word. The copied picture 
appears in your Word document. Double-clicking on this picture launches SmartDraw and 
you can make changes to the picture again.

Linking
The second type of behavior supported by OLE is Linking. Linking occurs between a client 
like Microsoft Word and an existing SmartDraw file. A link is established with SmartDraw 
drawing by using the Paste Special, (or Paste Link) command, that appears under the 
Edit menu, in Word and other clients.

Pasting a link is only possible if a copy occurred from a SmartDraw drawing that has a real
file name. Copying from an Untitled drawing will not allow a Paste Link.

When a link is pasted, the drawing appears in the Word document, just as it does with 
embedding (normal pasting). However, the drawing you see is an image of the entire 
SmartDraw file, not just the part that you copied. Any changes you make in the 
SmartDraw file are reflected inside the Word document the next time you open it. Two or 
more Word documents can be linked to the same SmartDraw file, and are automatically 
updated when changes are made to it.

SmartDraw is an OLE 1.0 Server. It not an OLE Client.



Drawing Shapes and Lines
There are two ways to draw both shapes and lines:

Drag and Drop
This method requires only one mouse click and gives you a shape or line with a standard 
size and shape. 

To add a rectangle shape, first click on the rectangle button on the toolbar without letting
go of the mouse button. Still holding down the mouse button, move the cursor onto your
drawing. (This is called dragging with the mouse.) A rectangle shape follows the cursor. 
Once you let go of the mouse button, a new rectangle is added to your drawing.

The size of the shapes you drag from the toolbar can be set by double-clicking on the 
shape button. This presents the Edit Toolbar Dialog. Lines created this way are always the 
same size and shape. (Lines are usually drawn using the Pencil method, described below). 
SmartDrawings can also be dragged and dropped from the SmartDrawing window.

Pencil
The pencil method requires two clicks but gives you full control over the size and shape of 
the object that you draw. 

To add a rectangle shape using this method, first click on the rectangle button in the 
toolbar, and then let go of the mouse button. As the cursor is moved into the drawing 
window it changes to the pencil cursor. Now if you click in the drawing window and keep 
the mouse button pressed and move the mouse, a rectangle is drawn, as if the mouse were
a pencil. This method can be used for shapes, lines and SmartDrawings.

For shapes that can be stretched to any proportion, like rectangles, perfectly square 
versions can be made using the pencil draw method. To do this, simply hold down the Ctrl 
key while drawing the shape. This trick with the Ctrl key also applies when re-sizing a shape
with the mouse.

Colors and Borders
New objects have properties that match the most recent changes made to the drawing. If 
you change the fill color of a shape to blue, and then create a new one, it will be initially 
filled with blue. If no changes have been made using the menus, the colors of new objects 
match the color and shadow style selected for the drawing.



Sizing Objects
You can change the size of a line or shape by first selecting it, and then clicking on one of 
the Selection Handles that appear on its border when it is selected.

Using the Mouse
To change the size of an object using its handles, click on one with the mouse and keep the 
mouse button held down. Then move the mouse. The handle that was clicked-on follows the 
movement of the mouse, changing the size of the object as it does.

For shapes that can be stretched to any proportion, like rectangles, perfectly square versions
can be made by holding down the Ctrl key while dragging with the mouse.

Shapes, like some SmartDrawings and Picture Objects, that normally can only be sized 
proportionately, can be stretched to any proportion, if you hold down the Shift key while 
dragging with the mouse.

Using the Arrow Keys
The arrow keys can also be used to adjust the size of an object. First the object must be 
selected. This is usually done by clicking on it. Typing an arrow key, while holding the down 
the Shift key, then increases or decreases the size of the object by 1/100" with each 
keystroke. The right and down arrows increase the size at the right and bottom. The left 
and up arrows decrease the size at the right and bottom.

These changes may be applied to more than one object simultaneously, if more than one is
selected.

Make Same Size
The Make Same Size command under the Draw menu can be used to make all selected 
objects the same size as the selected target object.



Moving Objects
Using the Mouse
Shapes and lines can be moved by clicking on them with the mouse, keeping the mouse 
button pressed down, and moving the mouse. An outline of the object clicked-on follows 
the mouse.

If more than one object is selected, and the Shift key is held down while the mouse is used
to move an object, all selected objects move as a group. More than one object may also be 
moved if the object clicked on is linked to others. When a group of objects is moved, an 
outline of the rectangle that encloses the group follows the mouse.

Using the Arrow Keys
The arrow keys can also be used to move an object. First the object must be selected. This 
is usually done by clicking on it. Typing an arrow key then moves the object by 1/100" with 
each keystroke. The right and down arrows move the object to the right and bottom. The 
left and up arrows move it to the left and up. If more than one object is selected, all are 
moved.

Aligning Objects
The Align command under the Draw menu can be used to align all selected objects with the
selected target object.



Background Color
The background of the drawing itself may be colored. The background color is changed 
using the Background Color command under the View menu. One of the selections is 
transparent. Drawings with transparent backgrounds differ from those with white 
backgrounds only in the way their pictures are exported. Drawings with transparent 
backgrounds export transparent pictures that acquire the background color of the 
document that displays them. Drawings with white backgrounds export pictures that have 
opaque white backgrounds, no matter where they are displayed.

Drawings exported in bitmapped formats are always opaque. 

The background color is one of the settings specified in the Color and Shadow style.



File Menu
New 
Creates a new drawing.

Open
Opens an existing drawing file.

Close
Closes the current drawing window

Save
Saves the current drawing to the same file.

Save As...
Saves the current drawing to a different file.

Printer Setup
Presents the standard Printer Setup Dialog.

Print
Prints the drawing.

Print Order Form
Prints the order form for Registration.

Export
Exports the current drawing in a graphic format that can be read by other programs.

Import
Imports pictures from other graphic programs.

Exit
Exits the program.

File Names
The up to four file names at the bottom of the file are the names of the most recently used 
files. Selecting one of these opens that file or brings it to the front.



Edit Menu
Undo
Undoes or re-does the last operation.

Cut
Copies the current selection to the clipboard and then deletes it.

Copy
Copies the current selection to the clipboard.

Paste
Pastes the current contents of the clipboard into the drawing

Clear
Removes the currently selected shapes and lines

Select All
Selects all lines and shapes in the drawing.

Duplicate 
Makes a copy of the currently selected objects

Colors and Shadows
Selects a new color and shadow style for the drawing.

Toolbar
Edits a shape button on the toolbar.

Options
Presents the Options Dialog.



Large SmartDrawings are not a good idea
The Windows metafile that you are attempting to add to the SmartDrawing library exceeds 
1,000,000 bytes. Metafiles of this size do not make good SmartDrawings.

Metafiles that are this large are usually very complex line drawings, or bitmaps. 
SmartDrawings are better when they are small and simple line drawings. Very complex 
drawings are slow and cumbersome. Bitmaps do not scale or print well at high resolution.

Try a simpler version of your image.



SmartDraw Templates
SmartDraw lets you save and re-open your own template files. A template file is exactly 
the same as a regular SmartDraw file, except that it has a file extension of SDT instead of
the normal SDR.

Opening
A template file is opened using the Open command under the File menu. This presents the 
Open File dialog. There are two choices of file type: SmartDraw File and SmartDraw 
Template. Choosing File opens a window with the same name as the file. Saving from this 
window updates the file. If Template is chosen however, an Untitled window is opened. 
Saving this file does not update the original but instead prompts you for a new file name. 
Opening a template file is just like creating a new drawing, except that it contains whatever
was stored in the template.

Saving
Any drawing may be saved to a template. To do this, use the Save As command, under the
File menu. This presents the Save Dialog. Again there are the same two choices of file type.
Selecting Template, saves the drawing to a template file with file extension SDT. Saving to 
a template does not rename the drawing to reflect the template name. The flag that 
indicates that changes have been made to the drawing is also not cleared, so that if you 
attempt to close the file, it will still prompt you to save changes.

New Drawings
The Options Dialog allows you to specify that the template SMRTDRAW.SDT be opened each
time you create a new drawing. This can be used to control the initial settings of your new 
drawings, even if the template file SMRTDRAW.SDT contains no shapes or lines. 
If you like a particular color and shadow style , for example, you can create a new drawing, 
select the color scheme you prefer, and save it as SMRTDRAW.SDT. If you place this file in 
the program directory, each new drawing you create will start with this style.

Setting default fonts for a new drawing requires that you set them for one shape. To do this,
add a shape and type "hello" inside. Select the shape so that it shows selection handles. 
Use the Typeface command under the Text menu to change the font, size and style of the 
text in the shape. You can also change the text color if you want to. Now delete the shape 
by typing the backspace key (while it is still selected). Save this drawing as a template. 
When re-opened, its default font, size and style will be set to the values you selected using 
the Font dialog.



Troubleshooting
Problems
If you experience problems (non-euphemistically known as bugs!) using SmartDraw 
please report them. The best way to do this is via electronic mail. Our email address is:

SmartDraw@AOL.COM

Email from Compuserve, AOL, or the Internet should reach us at this address. You can also 
call us at (619) 549 0314.

When reporting a problem, please include the following information:

1) Your system configuration (version of Windows, printer, display type etc.)
2) A description of how to reproduce the problem.
3) A sample file that exhibits the problem (if possible).

Solutions
Below are some answers to common problems. 
Printing
Q. My printer gives an out of memory error each time I try to print my drawing.
A. This is most commonly caused when you try to print a drawing that has a non-white 
background color, and you are printing with Print No Color box un-checked. This causes 
some printer drivers to send a full-page bitmap to the printer. Many LaserJet printers, in 
particular, do not come from the factory with enough memory to handle this. The solution 
is to change the background color to white, or to check the Print No Color box. Checking the
box will cause your drawing to print in pure black and white colors.

Q. My sideways text is not sideways when I print.
A. Not all printer drivers support sideways (rotated) text. Many that say they do, do not 
work properly. For LaserJet drivers that have this problem, checking the Print True Type 
fonts as Graphics box in the driver may help. Getting the latest version of the driver may 
also help. (Look on Compuserve or AOL). 

Switching fonts may also work. Sometimes True Type fonts are substituted by printer fonts 
at print time. These printer fonts may not support rotation. Substitutions of this kind are 
found in the WIN.INI file.

Q. My drawing looks completely wrong when I print it.
A. Some earlier versions of HP LaserJet printer drivers for Windows are not very reliable. If 
your print-out has text in the wrong place, or lines and shapes are jumbled up, try installing
the latest printer driver for your printer. For HP printers, you can get these from HP's forum 
on Compuserve. 

OLE and Copying



Q. Pictures from SmartDraw get scrambled when I paste them into other applications.
A. Most applications pick Windows metafiles apart when the are pasted into one of their 
documents. The Microsoft Office applications seem to do an excellent job of this. Other 
applications are not so capable. Corel Draw seems to have a problem with certain 
metafiles. There is not much you can do about this, but please report it so that we can work
with the vendor to try and fix the problem.

Q. When I paste a picture from SmartDraw into another application and double-click on it, 
SmartDraw is not launched. I thought SmartDraw supported OLE.
A. For OLE to work, the application you paste a SmartDraw picture into must be an OLE 
Client. OLE Clients usually have an Insert Object menu command.

SmartDrawings
Q. The SmartDrawing I added does not change color like other shapes.
A. Before this can happen you must check the Change colors box in the Edit SmartDrawing 
dialog. Even if this is checked, colors may not change as you expect. Bitmapped drawings 
in particular may not change color.

The rules are: All pens used follow the border style and color. Black fills follow the border 
color. Text color follows the border color. Non-black fills follow the Fill color. Transparent fills 
used by the drawing are left alone.



Technical Support
SmartDraw Software Inc. provides technical support under the following terms and 
conditions:

Registered Users
Up to 30 minutes of support is is provided at no charge for the first 90 days following 
registration.    Please have your registration number ready. This is shown clearly on your 
registration invoice, returned to you as part of the registered version.

After this date you may call with a credit card and obtain support at the rate of $7.50 per    
5 minutes. There is no charge for hold time, and no charge if the problem is identified as a 
"bug" in SmartDraw.    Whether the problem qualifies as a bug is at the sole descretion of 
SmartDraw Software Inc.

If a user reports a    bug that prevents proper use of the program during the first 90 days 
following registration, SmartDraw Software will either fix the bug, or offer a complete 
refund.

Non Registered Users
You may call for technical support with a credit card and obtain support at the rate of $7.50
per    5 minutes. There is no charge for hold time, and no charge if the problem is identified 
as a "bug" in SmartDraw.    Whether the problem qualifies as a bug is at the sole descretion 
of SmartDraw Software Inc.

You may also register over the phone with a credit card and obtain technical support at no 
charge under the terms of Registered Users described above.

Suggestions
We invite suggestions. There is never any charge for suggestions. Please contact us.

Getting Support
The best way to do this is via electronic mail. Depending on how simple your problem is, 
you may get e-mail support with no charge. Our email address is:

SmartDraw@AOL.COM

E-mail from Compuserve, AOL, or the Internet should reach us at this address.    You can 
also call us at (619) 549 0314.

When reporting a problem, please include the following information:
1) Your system configuration (version of Windows, printer, display type etc.)
2) A description of how to reproduce the problem.
3) A sample file that exhibits the problem (if possible).
See Troubleshooting.



ASP Ombudsman Statement
SmartDraw Software Inc. is a member of the Association of Shareware Professionals (ASP).   
ASP wants to make sure that the shareware principle works for you. If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for members' 
products. Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442-
9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe Mail to ASP 
Ombudsman 70007,3536.



Importing Pictures
Pictures from other programs, saved as disk files, can be imported into SmartDraw 
drawings via the Import Dialog. The name of the file that contains the picture to be 
imported is selected using the dialog controls in the same way as the Open Dialog.

The List Files of Type control changes the file extension of the files shown in the File 
Name list.    SmartDraw automatically detects the type of graphic file it is trying to import 
and the selection of the extension has no effect on the type of file that SmartDraw 
expects to find. There is only one choice of format for the regular version ofSmartDraw 
which supports the import and export of files in only in the Windows Metafile format. 

Once imported, pictures become Picture Objects and behave like rectangle shapes. Pictures
from other programs can also be imported via the Paste command.



Exporting
Drawings can be exported (saved) in standard Windows file formats via the Export Dialog. 
The name of the file to export to is specified using the dialog controls in the same way as 
the Save Dialog.

The List Files of Type control changes the format of the exported file. There is only one 
choice for the regular version of SmartDraw which supports the import and export of files 
only in Windows Metafile format 

SmartDraw drawings can also be exported to other applications via the Copy command 
and OLE.



Colors
Checking this box allows SmartDraw to change the color of the fills, lines, border and text 
that show in the SmartDrawing. The style and thickness of borders and lines can also be 
changed. These settings are controlled by the Shape menu, not the Line or Text menu.

The color of the text, lines and borders follows the Border Color setting. The fills follow the
Fill Color. Transparent fills are not affected by the Fill Color.

If this box is not checked, the drawing behaves like a Picture Object. Applying a border style
places a border around the SmartDrawing but does not change the contents.

The substitution of colors for lines, fills etc. may not work for all SmartDrawings. If the 
image contains bitmapped images these may be unaffected by checking the color box. If 
you check this box you should experiment with a copy of the SmartDrawing to see the 
effects of color changes. If these are not satisfactory, return to the dialog and uncheck the 
box again.



Image Window
The Image window shows the SmartDrawing image against a grid of green lines. A dotted 
border shows the edges of the drawing rectangle.

Each drawing has 16 Connect Points shown as solid black circles. These are the points at 
which lines and other shapes will Link to this drawing. Clicking on the circles and dragging 
with the mouse button held down allows you to move them. The connect points should be 
arranged on the borders of the drawing. To be active, connect points must lie outside the 
margin lines (whether text is entered Inside the Drawing or not).

You can finely adjust the position of connect points using the F5, F6, F7 and F8 keys. The 
point most recently clicked-on, moves left, right, up and down respectively by 1 pixel, when
these keys are typed.

When the text setting is Inside the Drawing, four margin lines appear. These can be 
moved by clicking on the square handles at each end and dragging. By default these are 
set to create the smallest text entry area possible between all four lines. This should be 
expanded to allow the largest area that still forces all text to lie within the borders of the 
shape. When text is entered    Above or Below the drawing, the margin lines are ignored.



Enter Text
SmartDrawings can display text. This text can be Inside the drawing like the standard 24 
shapes, or Above or Below it. The fourth choice, No text, means that the drawing will not 
respond to the normal text entry commands.

If Inside the Drawing is selected, four margin lines appear inside the Image window. 
These should be adjusted so that the text area within the four lines does not overlap the 
boundaries of the SmartDrawing.



Grow
The four radio buttons control the way in which the SmartDrawing can be re-sized. 

Proportional drawings have only four grow handles (one at each corner) and maintain 
their proportions when re-sized.

Horizontal Only drawings have only two grow handles and can be re-sized only in the 
horizontal direction. This is good for drawings that represent horizontal lines.

Vertical Only drawings have only two grow handles and can be re-sized only in the 
vertical direction. This is good for drawings that represent vertical lines.

No restrictions allows drawings to grow in all directions without maintaining proportions. 
These drawings have the usual 8 grow handles.



Preferred Size
The width and height fields control the size of the SmartDrawing when it is created using 
Drag and Drop. If the Grow setting is set to Proportional, changing one value changes the
other, so as to maintain the same proportions.



Creating and Editing SmartDrawings
SmartDrawings are regular Windows metafile pictures with special additional properties 
used by SmartDraw to control they way they change size, color and display text. The Edit
SmartDrawing dialog is used to change these properties both for existing SmartDrawings 
and newly added ones. 

Pressing the buttons below describes how each of the controls in the dialog works.

 Preferred Size
 Grow
 Enter Text
 Image
 Colors



SmartDrawing Libraries
Collections of SmartDrawings are stored in SmartDrawing Libraries. These are disk files. 
SmartDrawing Libraries usually collect together pictures that are used by a particular type 
of drawing. SmartDraw comes with libraries for Flow Charts, Forms, Computer Networks 
as well as a standard library that contains geometric shapes. The registered version of 
SmartDraw has more SmartDrawing libraries.

Opening a New Library
The most recently opened library is always re-opened when the SmartDrawing Window is 
shown. Its name is shown in the title bar of the window.

To select a different library, first open the SmartDrawing Window. This has its own menu 
bar. Select the Open Library command. This presents a standard Open File dialog listing 
any libraries with file extensions .SDL. Open the library file in the normal way. The 
SmartDrawing window will now show the contents of the library that you selected.

Creating a New Library
You can create your own SmartDrawing Libraries. To do this select the Create New 
Library command in the menu in the SmartDrawings window. This presents a standard 
Save File dialog. Name the new library and Press OK. This creates an empty library with the 
name that you entered. The SmartDrawing window will now show this name and, because it
is empty, shows no buttons. The next step is add your own drawings.

Adding Drawings to a Library
SmartDrawings are Windows Metafiles. Before you can add a drawing to the currently open 
SmartDrawing library you must first load a metafile into the Windows clipboard.

Metafiles are placed on the clipboard when you use the Copy command under the Edit 
menu in SmartDraw and many other graphics programs. Generally small, simple line 
drawings make the best SmartDrawings. To add a drawing to the currently open library, 
copy it to the clipboard and then select the Add New Drawing command under the 
SmartDrawing menu. The Edit SmartDrawing dialog is presented. This shows the image 
that you copied in the Image window. Double-click on the green text above for more 
details.

Editing an Existing SmartDrawing
To change the parameters (but not the picture) of an existing drawing, double click on its 
button, or select the button and then select the Edit Drawing command in the menu. This 
presents the Edit SmartDrawing dialog.

Removing a Drawing from the Library
To remove a drawing from a library, click on its button and select the Remove Drawing 
command in the menu. To change the picture of a SmartDrawing, you must remove it and 
then add a new copy.

Changing the Size of the Buttons



Each SmartDrawing in a library is shown on its own button in the SmartDrawing Window. 
For complex SmartDrawings, it is sometimes hard to recognize the image if the button is 
too small. You can overcome this by changing the size of the buttons using the three 
commands at the bottom of the SmartDrawing Menu: Small Buttons, Medium Buttons, 
and Large Buttons. Select the button size that best suits your library and display.



SmartDrawings
SmartDrawings are pictures than can be added to SmartDraw drawings, just like any of 
the standard shapes on the toolbar. 

SmartDrawing Libraries
Collections of SmartDrawings are stored in SmartDrawing Libraries. These are disk files. 
SmartDrawing Libraries usually collect together pictures that are used by a particular type 
of drawing. SmartDraw comes with libraries for Flow Charts, Forms and Computer 
Networks as well as a standard library that contains geometric shapes. The registered 
version of SmartDraw has more SmartDrawing libraries.

SmartDrawing Window
SmartDrawings are displayed in the SmartDrawing Window. This may be shown or hidden 
using the Show SmartDrawings command under the View menu. The SmartDrawing 
window shows rows of buttons, each displaying a different SmartDrawing from the current 
library. The name of the current library is shown in the window title bar.

The SmartDrawing window has its own menu. This is used to change libraries, create new 
ones and edit the contents of the current library.

The window is always re-opened automatically (in the same location) whenever the 
program is run and a drawing is opened, if it was left open when the last drawing was 
closed.

Adding SmartDrawings to a drawing
Clicking on one of these buttons is the same as clicking on a shape button in the Toolbar. 
Clicking and dragging, drags and drops a copy of the SmartDrawing shown on the button 
into the drawing. Clicking to select the button changes the cursor to a pencil and drawing 
with the pencil (by holding down the mouse and dragging) draws a new copy of the 
drawing.

See also: SmartDrawing Libraries, Creating and Editing SmartDrawings



Shapes
Shapes have the following properties, each of which has its own menu, or menu item under
the Shapes menu. Changes made using the Shapes menu apply only to shapes that are 
selected.

Fill Color
This determines the color inside the shape. This can be transparent, which means that the 
background of the drawing shows through. SmartDrawings that allow re-coloring, may also 
respond to fill color changes. The fill color changes any fills that are not black.

Border Style
A shape may have a border around its edge. This can be dotted, dashed, or solid with 
several thicknesses. Thick borders always grow towards the center of the shape. 
SmartDrawings that re-color respond to border style changes by changing their 
appearance. Those that do not show a border around the rectangle that encloses the 
drawing.

Shapes can also have no border. These are not visible unless their fill color differs from the 
background. Border-less shapes do not show shadows with all but drop shadow styles.

Border Color
This determines the color of a shape's border. If the border has no border, selecting a color 
gives it one. SmartDrawings that re-color respond to border color changes by changing 
their appearance. The border color controls the color of any lines, borders, text or areas of 
black. 

Shape
The shape menu allows you to change the shape of any standard shape to any other. 
SmartDrawings, background text objects or pictures do not respond to this command.

Text Sizing
Shapes may contain text. The details of text editing are described in Entering Text. Shapes 
grow as text is entered. The way the shape grows can be controlled using the Text Sizing 
command.



Lines
Lines have the following properties, each of which has its own menu, or menu item under 
the Line menu. Changes made using the Line menu apply only to lines that are selected.

Line Types
There are three classes of line: straight lines, segmented lines and curved lines. Each has 
its own button on the Toolbar.

Straight lines can have any direction. They snap to perfectly horizontal or vertical if drawn   
or grown in this direction.

Segmented lines are made up of 1 to 5 segments. These are usually used to Link shapes 
(or other lines) together. When linked to another object, the segment that touches the edge
of the object is always perpendicular to the edge. Hence the segmented line changes its 
shape and number of segments to maintain this relationship with its linked objects. The 
best way to understand this is to experiment with it.

Curved lines are arcs if they are not linked to other objects. They become curved versions 
of the segmented lines when linked.

The shape of linked curves and segmented lines can be adjusted by clicking on the 
selection handles.

Line Style
Lines can be dotted, dashed, or solid with several thicknesses.

Line Color
Lines can have any of the colors on the Line Color menu

Arrows
Lines may have the arrow styles shown on this menu.



Picture Objects
When pictures from other programs are imported or pasted into SmartDraw they become 
Picture Objects. These can be thought of as rectangle shapes, initially with no border, 
with the picture inside.

Picture objects can be moved and arranged like any other object. Normally they may only 
be sized so as to maintain their proportions, however, if you hold down the Shift key while 
you drag with the mouse, you can size them to any proportion.

Unlike shapes, when you try an enter text inside a picture object, it goes underneath 
instead of inside. Text underneath (or above) pictures and SmartDrawings may be selected 
separately and assigned borders and other attributes.

Pictures may be given borders using the Shape menu, but not fill colors.



View Menu
Fit to Window
Displays the whole drawing area in the window.

Fit to Page
Displays the drawing scaled so that at least one page shows in the window.

50%
Displays the drawing scaled to 50 % of its normal size.

75%
Displays the drawing scaled to 75% of its normal size.

100%
Displays the drawing at normal size.

150%
Displays the drawing scaled to 150% of its normal size.

200%
Displays the drawing scaled to 200% of its normal size.

Background Color
Changes the color of the drawing background.

Show Toolbar
Shows or hides the Toolbar.

Show Rulers
Shows or hides the rulers along the edge of a drawing.

Show Coordinates
Shows or hides the mouse coordinate display in the corner of the rulers.

Show SmartDrawings
Shows or hides the SmartDrawing window.



Line Menu
Style
Controls the thickness and pattern of lines.

Color
Controls the color of lines.

Arrowheads
Controls whether lines show arrowheads at their ends.



Text Menu
Typeface
This presents the Font Dialog, for selecting the typeface of selected shapes and text.

Color
Controls the color of selected text, or all text in selected shapes.

Alignment
Controls the horizontal and vertical position of text inside a shape.

Rotation
Allows background text objects to be rotated to vertical.

Insert Symbol
Inserts a symbol into a text entry session.

Bold, Italic, Underline, Superscript, Subscript
Changes the style of the text.



SmartDrawing Menu
Change Library
Opens a different SmartDrawing library in this window.

Create New Library
Creates a new (empty) SmartDrawing library in this window.

Close Library
Closes this SmartDrawing library and window.

Edit Drawing
Presents the Edit SmartDrawing dialog for currently selected drawing.

Add New Drawing
Allows the addition of any windows metafile currently on the clipboard to the library as a 
new SmartDrawing.

Remove Drawing
Removes the currently selected SmartDrawing from the library.

Small Buttons, Medium Buttons and Large Buttons
Controls the button size in the window.



Draw Menu
Align
Aligns selected objects with the target object.

Make Same Size
Makes selected objects the same size as the target object.

Bring to Front
Brings selected objects in front of un-selected objects.

Send to Back
Sends selected objects behind un-selected objects.

Lock Object
Locking prevents objects from being accidentally moved or edited. This command turns 
locking on and off.

Use Snaps
Turns the snap mechanism on and off.

Allow Lines to Link
Turns on and off the ability for lines to link to other objects.

Allow Shapes to Link.
Turns on and off the ability for shapes to link to other objects.



Welcome to SmartDraw! Software You Can Use!
SmartDraw is the easy-to-use program that lets anyone draw great looking flowcharts, 
diagrams and other business graphics. You don't have to be an artist to use SmartDraw.

SmartDraw automatically aligns shapes, lines and text. Its unique built-in library of design 
styles lets you pick professional looking color schemes, shadows, and textures for your 
drawings with the click of a mouse. Libraries of SmartDrawings provide an unlimited 
selection of clip-art, that you can edit or add to.

SmartDraw works as a stand alone program, and as part of the Microsoft Office, Lotus 
SmartSuite and programs that support Object Linking and Embedded (OLE).    You can insert
a SmartDraw drawing directly into Microsoft Word for Windows, using the Insert Object 
command.

The Welcome Dialog controls the following:

To Start lets you choose either to open a new drawing or go to the Open dialog when you 
press OK. You can change this setting permanently, (and stop showing the Welcome dialog)
using the Options command under the Edit Menu. (You must create or open a drawing 
first).

If the Beginning Users box is checked, SmartDraw will pop-up beginning user messages 
the first time that you try something new, to help you understand how it works. These can 
be switched off at any time in any of the messages that pop-up.    The appearance of 
beginning user messages can also be controlled from the Options Dialog.

Tips are helpful hints that bring some of the richer features of the program to your 
attention. You can browse through these using the Next and Previous buttons. The 
Details button presents a help screen describing the tip in more detail. You can look at the 
tips at any time using the Tips command under the Help Menu.

Unchecking the Show Welcome Dialog box will prevent the Welcome dialog from coming 
up the next time that you run the program. This can also be controlled from the Options 
dialog.



SmartDraw Software License Agreement

Grant of License
This SmartDraw license agreement grants you a non-exclusive right to load and use the 
SmartDraw Software Shareware Version 1.0 (the "Software") for a period of 30 days from 
the date that the software was first loaded on one or more computers. Once the 30 day 
period has expired, you (the licensee) agree to either purchase a permanent license to use 
the software, or to destroy the Software and all copies in your possession.

The software is "loaded" onto a computer when it is either copied to the permanent 
memory of the computer (the hard disk) or loaded into the temporary memory (RAM), such 
as when a computer runs the software from a network server, or a floppy disk.

Copyright
The Software is owned by SmartDraw Software Inc. and is protected by United States 
copyright laws and international treaty provisions. You must treat the software like any 
other copyrighted material (for example, a book), except that you may make a copy for the 
purposes of loading it onto the hard disk of the computers that are licensed under this 
agreement.

Other Restrictions
You may not transfer your rights under this agreement. You must not rent or lease this 
Software. You may not decompile or disassemble the Software. You may not distribute the 
Software as part of any of any other software, or collection of software without the 
agreement of SmartDraw Software Inc.

Distribution
The shareware version of SmartDraw may distributed only under the terms and conditions 
of the Distribution License shown in the file VENDOR.TXT.

LIMITED WARRANTY AND DISCLAIMER OF WARRANTY 
THIS SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING INSTRUCTIONS 
FOR USE) ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. FURTHER, 
SMARTDRAW SOFTWARE INC. DOES NOT WARRANT, GUARANTEE, OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF USE, OF THE SOFTWARE OR 
WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS,
OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE 
SOFTWARE IS ASSUMED BY YOU. 
IF THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE YOU, AND NOT 
SMARTDRAW SOFTWARE INC. OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, 
ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.
 
THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, THAT IS MADE BY SMARTDRAW SOFTWARE INC., ON 
THIS SMARTDRAW SOFTWARE INC. PRODUCT. NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SMARTDRAW SOFTWARE INC., ITS DEALERS, DISTRIBUTORS, AGENTS OR 
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS 
WARRANTY AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. YOU MAY 
HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.
 
NEITHER SMARTDRAW SOFTWARE INC. NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN 



THE CREATION, PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY 
DIRECT, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING 
DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH 
PRODUCT EVEN IF SMARTDRAW SOFTWARE INC. HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES.
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SmartDraw Pro
SmartDraw Pro contains many more SmartDrawings and features including:

- Open up to four SmartDrawing libraries at the same time
- Adjust the outlines of rounded rectangles, and other shapes
- Fill shapes with hatched patterns
- Change the sizing and coloring properties of imported pictures.
- Import bitmapped images (TIFF, BMP, PCX) as well as WMF files
- Draw lines with Comm. and Digital styles
- Organize flow charts in hierarchies, by attaching other SmartDraw drawings to shapes
- Organize your SmartDrawings: Drag and drop SmartDrawings from one library to another.
- See the names of SmartDrawings as well as their thumbnail images
- Hide and show shadows for individual shapes, lines and text
- Flip SmartDrawings and pictures upside down and across.

Additional SmartDrawings include:
More Business, more Holidays, Computers, International, Publishing, Food and 
Restaurant, Shapes, Symbols, Transport and 100 more computer network and 
communications drawings.



How to Register SmartDraw
Register SmartDraw or SmartDraw Pro
SmartDraw is a registered version of the program you are now using. There are no "Nag" 
screens, many more SmartDrawings and a printed manual. SmartDraw Pro has more 
features and more SmartDrawings.

Registering Is Easy
There are three simple ways to register:
1) Double-click on your country below and the correct order form will show in this Help 
window. Print it out using the Print Topic command under the File menu shown in the 
Help window. Then mail, fax or call the address shown on the form.

BudgetWare                                 Australia  
WindowShare                               France  
CopyCats                                     Netherlands  
The Thompson Partnership       UK  
SmartDraw Software                  USA, Canada and all others  

2) Print the US order form using the Print Order Form command under the SmartDraw 
File menu. Or call SmartDraw Software Inc. at (619) 549 0314. The cost to register 
SmartDraw is just $35 for a single user license. SmartDraw Pro is $49. The order form 
contains all the details.

3) If you are a Compuserve subscriber you can register on-line. Just GO SWREG. 
SmartDraw's Registration ID is 4133. SmartDraw Pro's ID is 4134.

Here are five great reasons why you should register SmartDraw.
1) It's the right thing to do.
Shareware is not free but it comes with the ultimate money back guarantee: If you don't 
like it AND DON'T USE IT, don't pay for it. However, if you do use it you should pay for it, 
otherwise there wouldn't be any shareware.

2) Not registering is against the law
If you use SmartDraw for more than 30 days after you install it, and you have not 
registered it, you are in violation of your license agreement. If you are using it on more 
computers than you have licenses for, you are also in violation of the law. Why put your self
and your company at risk for a few dollars?

3) Get many more SmartDrawings and templates
The registered version of SmartDraw comes with more than 100 additional 
SmartDrawings and Templates. The additional SmartDrawing libraries contain gorgeous 
full color clip-art and include: Holidays, Business, Presentations, Block Diagrams and 
Things. SmartDraw Pro features more than 350 additional SmartDrawings.

4) Get a printed manual



Registered SmartDrawcomes with its own bound and printed manual, with index and table
of contents.

5) Notification of updates and add-ons
Once you are registered you will be notified automatically of future updates, more 
SmartDrawing libraries and other goodies.

6) Technical support
Get 90 days of free support.



US Order Form [Print this form using the Print Topic command]

To purchase a copy of SmartDraw or SmartDraw Pro, either:
+Mail this form and payment to: SmartDraw Software Inc., 

9974 Scripps Ranch Blvd, #35, San Diego, CA 92131, USA
+or, Fax the form, with credit card information filled in below, to (619) 549 2830
+or, call SmartDraw at 1-(800) 501 0314 [Outside US, or tech support, call (619) 549 0314.]
+or, order on-line using Compuserve. Just GO SWREG, and order product number 4134.

Name_________________________________    Company______________________________
Street________________________________________________________________________    
City__________________________ State_____ ZIP___________ Country________________
Phone ____________________ Fax _____________________ EMail____________________
Select the type of license required: [Prices good through 1995]

___ Individual Use License
This is a license that permits the use of SmartDraw (or Pro)    on a single computer, or on up to two computers used exclusively by 
the same individual user. It includes one copy of the program and its documentation.

SmartDraw Pro………………… Copies required _____ x $49.00(US)………… ______
SmartDraw………………………Copies required _____ x $35.00(US)………… ______

___ Multiple Use License
This is a license that permits the use of SmartDraw on a more than one computer used as the same site (a site license), or on the 
same network. It includes only one copy of the program and documentation.    You may buy any combination of 1, 10, or 100 copy 
licenses to meet your needs.

SmartDraw Pro
10 Computers or less………… Copies required _____ x $350.00(US)………… ______
100 Computers or less……… Copies required _____ x $2800.00(US)………… ______

SmartDraw
10 Computers or less………… Copies required _____ x $250.00(US)………… ______
100 Computers or less……… Copies required _____ x $2000.00(US)………… ______

Extra Manuals and Disks……… Copies required _____ x $5.00(US)…………… ______

Clip Art
Images with Impact is a collection of 1000 metafile images that can be imported into SmartDraw/SmartDraw Pro.

Images with Impact………… Copies required _____ x $49.00(US)………… ______

Total and Payment Method (Call First for Purchase Orders.)
Credit Card Information. (Visa ,MasterCard and American Express). Subtotal ($US)……… ______
Number: __ __ __ __    __ __ __ __    __ __ __ __    __ __ __ __      CA residents add 7%    tax ______
Name:          __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __      Shipping & Handling… ______
Expires    __ __    / __ __      Signature_______________________ (US=$5, Non-US=$10)

Payment Method:    ___    Credit Card        ___ Check or Money Order
3.5" Disks (1.44MB) Only Total ($US)……… ______



SmartDraw Ordering Information
There are two different versions of SmartDraw that you can order, along with a huge collection of clip art.
SmartDraw is the same program that you are now using, but with some additional templates and 
SmartDrawings, as described below.
SmartDraw Pro is a more advanced version of SmartDraw. It has additional features and many more
templates and SmartDrawings than SmartDraw. 
Images with Impact! is a collection of clip art that you can import into either version of SmartDraw.

SmartDraw
The registered version of SmartDraw includes:

+ More than 100 additional SmartDrawings (A $25 value) including the following SmartDraw libraries: 
Holidays, Business, Presentations, Things, Block Diagrams, Road maps.

+ No registration reminders

+ A 100 page printed and bound manual, with index and table of contents

+ 90 days of paid support

+ Notices of updates, and additional offers

All this for $35. TERRIFIC VALUE!

SmartDraw Pro
SmartDraw Pro includes everything listed above for SmartDraw, plus:

+ A total of 350 additional SmartDrawings and templates (a $75 value).

+ Publishing Templates. These professional-looking backdrops and borders, arranged on a single page, make 
the perfect design for fliers, notices, invitations, and posters. This makes SmartDraw Pro a publishing tool, as 
well as a drawing program.

+ More features. Open 4 SmartDrawing Libraries at the same time, Hide individual shape shadows, Adjust shape
curves and angles, Export and Import in PCX, BMP, TIFF,    and more..

If you are going to register, pay only $14 more and get $50 more of additional SmartDrawings and
Templates and more features! Buy SmartDraw Pro for only $49. EXCEPTIONAL VALUE!

Images with Impact!
Images with Impact! is a commercial collection of more than 1000 images in Windows Metafile (WMF) 
format from 3G Graphics Inc., many in full color. These can be imported into SmartDraw and Pro. 
Images with Impact! covers presentations, home, office, business, sports, holidays, health, travel and 
more. You can add the imported images to your own SmartDraw Libraries, or create template files. Like 
SmartDraw Pro, many of these images are publishing backdrops, and make SmartDraw an even better 
tool for creating flyers, posters, invitations and notices.
You can buy Images with Impact, a $120 value for a special price of only $49.00 when you order 
SmartDraw or SmartDraw Pro.



UK Order Form [Print this form using the Print Topic command]

The Thompson Partnership (United Kingdom)
You can order from The Thompson Partnership by payment with cheque or credit card.    The credit 
cards accepted are: MC, Visa, Diners Club, and American Express.    

Telephone Orders: +44 (0) 1889 564601 Fax Orders:+44 (0) 1889 563219
Internet Orders: sales@ttp.co.uk Internet Support: support@ttp.co.uk

Please use this form when ordering by fax or mail:
Name ______________________________Company_________________________________
Address _____________________________________________________________________
Town ______________________________ City _____________________________________
Country ________________ Postal Code ___________Telephone ______________________

Credit Card Type _____________Credit Card Number ________________________________
Expiration Date      _______VAT Number (EC Residents) _______________________________

Program Quantity Price Each Price Total
SmartDraw (Registered Version) ______ £23.95 ______
SmartDraw Pro ______ £34.95 ______
SmartDraw (Registered Version) 10 License Pack ______ £169.00 ______
SmartDraw (Registered Version) 100 License Pack ______ £1350.00 ______
SmartDraw Pro 10 License Pack ______ £239.00. ______
SmartDraw Pro 100 License Pack ______ £1890.00 ______
Additional Disks & Documentation (for multi-license pack) ______ £3.50 ______
Images with Impact! Clipart collection  ______ £49.00 ______
Total ______
Shipping £3.00
VAT (EC REsidents only) @ 17.5% ______
Total ______
Make cheques or EuroCheque payable to: The Thompson Partnership.
(Be sure your card number is on the reverse of the Eurocheque)

Mail to:
The Thompson Partnership
Lion Buildings
Market Place
UTTOXETER,
Staffs.
ST14 8HZ,    UK



SmartDraw Ordering Information
There are two different versions of SmartDraw that you can order, along with a huge collection of clip art.
SmartDraw is the same program that you are now using, but with some additional templates and 
SmartDrawings, as described below.
SmartDraw Pro is a more advanced version of SmartDraw. It has additional features and many more
templates and SmartDrawings than SmartDraw. 
Images with Impact! is a collection of clip art that you can import into either version of SmartDraw.

SmartDraw
The registered version of SmartDraw includes:

+ More than 100 additional SmartDrawings (A £15 value) including the following SmartDraw libraries: 
Holidays, Business, Presentations, Things, Block Diagrams, Road maps.

+ No registration reminders

+ A 100 page printed and bound manual, with index and table of contents

+ 90 days of paid support

+ Notices of updates, and additional offers

All this for £23.95. TERRIFIC VALUE!

SmartDraw Pro
SmartDraw Pro includes everything listed above for SmartDraw, plus:

+ A total of 350 additional SmartDrawings and templates (a £50 value).

+ Publishing Templates. These professional-looking backdrops and borders, arranged on a single page, make 
the perfect design for fliers, notices, invitations, and posters. This makes SmartDraw Pro a publishing tool, as 
well as a drawing program.

+ More features. Open 4 SmartDrawing Libraries at the same time, Hide individual shape shadows, Adjust shape
curves and angles, Export and Import in PCX, BMP, TIFF,    and more..

If you are going to register, pay only £11 more and get £50 more of additional SmartDrawings and
Templates and more features! Buy SmartDraw Pro for only £34.95. EXCEPTIONAL VALUE!

Images with Impact!
Images with Impact! is a commercial collection of more than 1000 images in Windows Metafile (WMF) 
format from 3G Graphics Inc., many in full color. These can be imported into SmartDraw and Pro. 
Images with Impact! covers presentations, home, office, business, sports, holidays, health, travel and 
more. You can add the imported images to your own SmartDraw Libraries, or create template files. Like 
SmartDraw Pro, many of these images are publishing backdrops, and make SmartDraw an even better 
tool for creating flyers, posters, invitations and notices.
You can buy Images with Impact, a £90 value for a special price of only £40.00 when you order 
SmartDraw or SmartDraw Pro.



Enregistrement de SmartDraw

WindowShare SARL (France)
Faites FICHIER|IMPRIMER LA RUBRIQUE pour imprimer le bon de commande
Paiement par chèque bancaire ou postal, eurochèque ou carte de crédit (MasterCard et Visa).

Adresser ce bon de commande à : Téléphone : +33 87 30 85 57
WindowShare SARL Télécopie : +33 87 32 37 75
BP 2078 Minitel : 3615 WinShare
57051 - METZ cedex 2 CompuServe : Go WSHARE

Nom ________________________________________________
Société ______________________________________________
Adresse ______________________________________________
Adresse ______________________________________________
Code Postal ___________Ville    ___________________________
Pays _______________________    
Téléphone ________________________________
Numéro de carte de crédit ________________________________
Date d'expiration _____________/______________

Prix valables en 1995 seulement.
Licences individuelles
SmartDraw Pro……………… Copies    _____ x FF 440………… ______
SmartDraw…………………… Copies    _____ x FF 345………… ______
SmartDraw standard, c'est plus de 100 SmartDrawings supplémentaires, des dessins de toutes catégories, la fin 
des écrans de rappel, et un manuel de plus de 100 pages
SmartDraw Pro, c'est le SmartDraw qui précède, plus un total de 350 SmartDrawings supplémentaires, et des 
modèles de documents, des fonds d'écran, des cadres, pour faciliter la production de vos propres créations. SD Pro
vous permet d'ouvrir jusqu'à quatre bibilothèques de SmartDrawing simultanément, d'export et d'importer en PCX, 
BMP, TIFF,    etc. Une véritable affaire !
Nous contacter pour des licences multiples
Offre sépciale : Clip Art de Qualité Supérieure
Images with Impact est une collection de 1000 images au format WMF.

Images with Impact………… Copies    _____ x FF 599 ………… ______

Total FF……… ______
Disquette :    ___ 3.5" (1.44MB)      ___ 5.25" (1.2MB)
Prix TTC, port (25 F) compris. 
Pour une livraison hors France Métropolitaine et étranger, ajouter FF 10 au total de votre facture.



Bestelformulier Nederland & België
[druk af m.b.v. Print Topic commando]
Met dit formulier kunt u in Nederland of België de geregistreerde versie van SmartDraw bestellen. Stuur 
het formulier gelijktijdig met uw betaling in Dfl of BF naar:

CopyCats
Postbus 1088 Tel. vanaf 10-10-95: +31 (0) 7257-45993
1700 BB Heerhugowaard Email 100121.1562@compuserve.com
Nederland Postbank (NL) 43.28.577
Telefoon/Fax: +31 (0) 2207-45993 Postcheque (B) 000-1656064-80

Er zijn twee uitvoeringen van SmartDraw leverbaar. SmartDraw is het programma dat u thans gebruikt, 
met een aantal extra's die onderaan dit formulier besproken worden. SmartDraw Pro is een uitgebreide 
uitvoering, die een aantal speciale features en nog meer extra's biedt. Ook leverbaar is "Images with 
Impact!", een omvangrijke verzameling clipart-plaatjes die in beide versies van SmartDraw geimporteerd
kunnen worden.

Ik bestel:
Aantal: Produkt: Prijs p/s: Totaal:
.... SmartDraw Dfl 78,50 / 1450 BF ..........
.... SmartDraw Pro 107,50 / 1990 BF ..........
.... Images with Impact! 158,50 / 2930 BF ..........

Verzendkosten 8,50 / 160 BF ..........
----------

Totaal: ..........
=====

Betaalwijze:
[    ]    Bijgesloten eurocheque of girobetaalkaart

[    ]    Overmaking naar Postbank 43.28.577 (NL) Datum, Handtekening:

[    ]    Overmaking naar Postcheque 000-1656064-80 (B)

[    ]    Rembours (Dfl. 10,- extra / alleen in NL)

[    ]    Factuur (bedrijven/onderwijs/overheid na acceptatie) ________________________________

Naam________________________________    Bedrijf_______________________________
Adres_____________________________________________________________________
Postcode___________ Plaats_____________________________ Land _______________
Tel. ____________________ Fax _____________________ EMail____________________
BTW/TVA nummer (bedrijven België) ________________________
Prijzen zijn inclusief 17,5% BTW en onder voorbehoud. Bel voor informatie over voordelig geprijsde site-licenses.

* Dank u voor uw registratie van SmartDraw software! *



SmartDraw, SmartDraw Pro en Images with Impact! produktinformatie:

SmartDraw:
Bij registratie van SmartDraw kriijgt u:
+ Meer dan 100 extra SmartDrawings (t.w.v. $25) uit de volgende libraries: Holidays, Busi-ness, 

Presentations, Things, Block Diagrams en Road maps;
+ Geen registratie-herinneringen meer;
+ Een handboek van 100 pagina's met index;
+ 90 dagen technische ondersteuning;
+ U wordt op de hoogte gehouden van upgrades en andere aanbiedingen.
SmartDraw: Slechts Dfl. 78,50 / 1450 BF

SmartDraw Pro:
SmartDraw Pro omvat al het onder SmartDraw genoemde, plus:

+ Totaal 350 extra SmartDrawings en Templates (t.w.v. $75);
+ "Publishing Templates". Achtergronden en kaders die uw folders, correspondentie, posters en andere 

mededelingen een professioneel uiterlijk verlenen. Hiermee wordt SmartDraw Pro ook als DTP-
programma bruikbaar!

+ Meer mogelijkheden: tot 4 SmartDrawing Libraries tegelijk actief, meer controle over schaduw-
effecten, aanpassen van rondingen en hoeken, export en import van PCX, BMP, TIFF, en meer..

SmartDraw Pro: slechts Dfl 107,50 / 1990 BF

Images with Impact!
Images with Impact!, een commerciële clipartverzameling van 3G Graphics Inc., biedt meer dan 1000 
afbeeldingen in Windows Metafile (WMF) formaat, waaronder vele in kleur. Deze kunnen in SmartDraw 
en Pro geimporteerd worden. Thema's zijn ondermeer Presentations, Home, Office, Business, Sports, 
Holidays, Health en Travel. U kunt deze afbeeldingen aan uw eigen SmartDraw Libraries toevoegen of 
in templates gebruiken. Veel zijn ook geschikt om in publicaties als achtergrond te gebruiken. Wie 
Images with Impact! tegelijk bestelt met Smart-Draw of SmartDraw Pro, betaalt slechts Dfl. 158,50 / 
2930 BF (vgl. winkelwaarde Dfl 250,-).



Australian Order Form [Print this form using the Print Topic command]

To purchase a copy of SmartDraw or SmartDraw Pro, either:
+Mail this form and payment to: BudgetWare, PO Box 496, Newtown NSW 2042, Australia
+or, Fax the form, with credit card information filled in below, to (02) 516-4236
+or, call BudetWare at (02) 519-4233
Name_________________________________    Company______________________________
Street________________________________________________________________________    
City_________________________ State______ Code___________ Country_______________
Phone ____________________ Fax _____________________ EMail____________________
Select the type of license required: [Prices good through 1995]

___ Individual Use License
This is a license that permits the use of SmartDraw (or Pro)    on a single computer, or on up to two computers used exclusively by 
the same individual user. It includes one copy of the program and its documentation.

SmartDraw Pro………………… Copies required _____ x $79.00……………… ______
SmartDraw………………………Copies required _____ x $59.00……………… ______

___ Multiple Use License
This is a license that permits the use of SmartDraw on a more than one computer used as the same site (a site license), or on the 
same network. It includes only one copy of the program and documentation.    You may buy any combination of 1, 10, or 100 copy 
licenses to meet your needs. Call, if necessary, for more information.

SmartDraw Pro
10 Computers or less………… Copies required _____ x $565.00……………… ______
100 Computers or less……… Copies required _____ x $4500.00……………… ______

SmartDraw
10 Computers or less………… Copies required _____ x $420.00……………… ______
100 Computers or less……… Copies required _____ x $3400.00……………… ______

Extra Manuals and Disks……… Copies required _____ x $10.00………………… ______

Clip Art
Images with Impact is a collection of 1000 metafile images that can be imported into SmartDraw/SmartDraw Pro.

Images with Impact………… Copies required _____ x $99.00……………… ______

Total and Payment Method (Call First for Purchase Orders.)
Credit Card Information. (Bankcard, Visa and MasterCharge Only). Shipping & Handling… ______
Number: __ __ __ __    __ __ __ __    __ __ __ __    __ __ __ __      (AUS=$5, Non-AUS=$10)

Name:          __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __      
Expires    __ __    / __ __      Signature_______________________
Payment Method:    ___    Credit Card        ___ Check or Money Order
Disk Size:    ___ 3.5" Disks (1.44MB)      ___ 5.25" Disks (1.2MB) Total ($AUS)……… ______

SmartDraw Ordering Information



There are two different versions of SmartDraw that you can order, along with a huge collection of clip art.
SmartDraw is the same program that you are now using, but with some additional templates and 
SmartDrawings, as described below.
SmartDraw Pro is a more advanced version of SmartDraw. It has additional features and many more
templates and SmartDrawings than SmartDraw. 
Images with Impact! is a collection of clip art that you can import into either version of SmartDraw.

SmartDraw
The registered version of SmartDraw includes:

+ More than 100 additional SmartDrawings (A $40 value) including the following SmartDraw libraries: 
Holidays, Business, Presentations, Things, Block Diagrams, Road maps.

+ No registration reminders

+ A 100 page printed and bound manual, with index and table of contents

+ 90 days of paid support

+ Notices of updates, and additional offers

All this for $59. TERRIFIC VALUE!

SmartDraw Pro
SmartDraw Pro includes everything listed above for SmartDraw, plus:

+ A total of 350 additional SmartDrawings and templates (a $125 value).

+ Publishing Templates. These professional-looking backdrops and borders, arranged on a single page, make 
the perfect design for fliers, notices, invitations, and posters. This makes SmartDraw Pro a publishing tool, as 
well as a drawing program.

+ More features. Open 4 SmartDrawing Libraries at the same time, Hide individual shape shadows, Adjust shape
curves and angles, Export and Import in PCX, BMP, TIFF,    and more..

If you are going to register, pay only $20 more and get $65 more of additional SmartDrawings and
Templates and more features! Buy SmartDraw Pro for only $79. EXCEPTIONAL VALUE!

Images with Impact!
Images with Impact! is a commercial collection of more than 1000 images in Windows Metafile (WMF) 
format from 3G Graphics Inc., many in full color. These can be imported into SmartDraw and Pro. 
Images with Impact! covers presentations, home, office, business, sports, holidays, health, travel and 
more. You can add the imported images to your own SmartDraw Libraries, or create template files. Like 
SmartDraw Pro, many of these images are publishing backdrops, and make SmartDraw an even better 
tool for creating flyers, posters, invitations and notices.
You can buy Images with Impact, a $180 value for a special price of only $99.00 when you order 
SmartDraw or SmartDraw Pro.




